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Appendix A: Creating simple Views 

A view is a list of articles in a database.  Views let you sort, categorise and select 
articles. They display information about the articles. 

Views can be created by any person with the access to read articles in a database.  
The person creating a view specifies the view criteria so that only articles fulfilling 
particular criteria will be listed in that view. 

Views are similar to folders, except that views are automatically updated as articles 
are added to and deleted from your database. 

L see chapter 4: Views for information and instructions about using edDesk’s 
standard views. 

OBJECTIVES 

By the end of this chapter you should be able to: 

• create simple views 

• use your views to list articles fitting the view criteria 

• go to required views 

• edit your views 

• rename views 

• delete views (that you created) when they are no longer needed. 

CREATING A SIMPLE VIEW 

The easiest way to create a view is to base it on a view that is already in your 
database, and then just adjust the conditions and information that you want to 
display. This gives your view a better chance of working, and can avoid a lot of 
frustration! When you have more experience, you can create a view “from scratch”. 

1. Go to the Home tab. 

2. Select the Create menu. 

3. Select View…. The Create View dialogue box displays. 
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Figure 199: Create view dialogue box with default information displayed 

4.	 View name: enter a name for your view. 

5.	 View type: Your choices are: 

•	 Shared - this is the default. Shared allows anyone with access to 
the database to use this view. 

•	 Shared, contains documents not in any folders – DON’T WORRY 
ABOUT THIS ONE 

•	 Shared, contains deleted documents – Lets you see a list of deleted 
articles. Useful if you have accidentally deleted some articles, 
because it helps you retrieve them. 

•	 Shared, private on first use – DON’T WORRY ABOUT THIS 
ONE. 

•	 Shared, desktop private on first use – DON’T WORRY ABOUT 
THIS ONE. 

•	 Private – can only be used by the person who created it, and the 
database administrators. 

6.	 Select a location for the view. If your View Type is Private you can only 
put your new view into your list of private views. 

7.	 Copy style from view: The default is All documents. This means that your 
new view will inherit the columns of information that display in the All 
documents view. This is a good thing to do when you are creating your first 
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view (as the All documents view works properly!)  You can add your own 
criteria for articles to be listed in your view. 

L see section for more information on creating views from scratch. 

8.	 Selection conditions: If you have left the Copy style from view as All 
documents, this field displays a lot of criteria for articles to be listed in the 
All documents view.  Don’t do anything to this field. 

9.	 Select by formula. Uncheck this!  Then the Create view dialogue box 
changes slightly to let you add conditions for your view. 

Figure 200: Create View dialogue box with “Select by formula” unchecked.  Now 
you can Add Conditions for your view. 

10.	 Click on <Add Condition…>. The Add Condition dialogue box displays. 
Remember that only articles that match the conditions you enter here will 
be displayed by your view. 

L see section 5.6i: Conditions for more information on adding conditions. 

11.	 Add the required conditions. 

12.	 Click on <OK>. The view is saved. 

GOING TO YOUR VIEW 

When you created your view, you selected a location for it.  To use your views you 
must “go to” them.  Private views can only be saved in your list of private views. 

The easiest way to go to one of your views is to display a standard edDesk view.  
When you are in a view you can then tell edDesk to go to your view. 
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1.	 Display any view (a simple one is All Issues, as there will be articles 
listed). 

2.	 Click once on any article in the view (you don’t have to do this if you are 
using the All Issues view). 

3.	 Select the View menu. 

4.	 Select Go To… 

5.	 The Go To dialogue box opens, listing all views. 

Figure 201: Go To dialogue box.  Your private views are at the bottom of this list. 

6.	 Your private views are at the end of the list.  Scroll down to the required 
view. 

7.	 Click on the view you want to go to. 

8.	 Click <OK>. 

9.	 Your view is displayed. 

CUSTOMISING A VIEW 

Customising is a simple way of letting you change which columns display, the order 
in which columns are displayed and whether they are sorted.  Customising does 
NOT let you edit the view conditions. 

1.	 Go to the view to be customised. 

L see Going to your view for instructions. 

2.	 Select the View menu. 

3.	 Select Customize This View…. The Customize View dialogue box 
displays. 
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Figure 202: Customize View dialogue box 

Columns to Display 

Columns are listed with the leftmost column at the top.  The first column is selected 
(highlighted in blue). 

Information displayed here is: 

•	 Visible: All of your columns are checked by default. If you click 
on the checkbox (and the tick is removed) your column will not 
display in the view. 

•	 Name: This is the name of the column.  This can only be changed 
in the Design View window. L see Designing views for more 
information. 

•	 Sort: Indicates whether the column is sorted. 

•	 Width: Width of the column as it is displayed. 

•	 Resizable: If this is Yes you can change the width of the column. 

•	 Selected Column: This lets you change the sort method and width 
of the selected column. 

o	 Sort: Choose from None, Ascending and Descending. 
Ascending will sort in increasing order – the most recent 
articles are at the bottom of the view.  Descending will 
sort in decreasing order – the most recent articles are at 
the top of the view. 

o	 Width: you can change the width of the selected column, 
wherever they are shown as Resizable. 
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1.	 Make sure that any column you want to display has a tick in the Visible 
checkbox. 

2.	 Use the <Move Down Ø> and <Move Up ×> buttons to reorder the 
columns from left to right.  <Move Down Ø> moves your column to the 
right, <Move Up ×> moves it to the left. 

 Entire View 

Information you can change here is: 

•	 Row spacing: You can set the vertical spacing between each row 
in the view. The default of 1¼ is usually the easiest to look at 
without having too much space between rows. 

•	 Lines per row. This is the maximum number of text lines per row 
in the view. If you have articles with lengthy subjects you may 
want to increase this so that the subject is not truncated by the view 
display. 

•	 Shrink rows to content: Tick this to make sure that shorter text 
lines do not take up the maximum lines per row (and leave too 
much gap between rows of articles returned by your view). 

1.	 Make the required changes. 

2.	 Click <OK> to save the customised view. 

3.	 Your view is displayed, showing the customisations you have made. 

DESIGNING VIEWS 

Creating a simple view covered creating a simple view, based on the All Documents 
view. 

This section tells you how to design (and redesign) your view so that you can give 
your columns a different name, make them appear in a different order and change 
some other display aspects of your view.  Designing allows you to make more 
changes to your view than Customisation does. 

This section does not cover advanced aspects of designing views.  Please see the 
Lotus Help for more information on how to perform more advanced customisations. 

Programming not covered 

This User Guide does NOT cover programming your view.  It does cover editing the 
conditions you set when creating the view and changing some simple display 
elements of your view.  See your System Administrator if you need a more complex 
view that involves programming. 

1.	 Go to the view that you want to alter. 

L see Going to your view for instructions. 

2.	 Select the Actions menu. 

3.	 Select View Options. 

4.	 Select Design… 
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5. The Design View pane opens. This contains some technical information, 
which you don’t need to know about! 

Figure 203: Design view pane, showing the information when your view is based 
on the "All Documents" view 

The top half of the Design View pane contains is the View Preview. If you 
want to see a list of the articles returned by your view, click on 
<Refresh (F9)> or the  at the left of the column headings. 

The bottom half of the Design View pane is where you make your changes 
to the view.  It is split into two parts – the left column contains elements of 
your view (this is technical and is not covered in this User Guide).  The 
right column contains the programming details which make the elements in 
the left column work properly (this is also not included in this User Guide). 

Instructions for making simple changes to a view are below. 

Modifying selection conditions 
Selection conditions determine which articles are listed by your view. 

1. Click on the Selection Conditions icon -
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2. The current selection conditions are displayed in the bottom right pane of 
the Design pane. 

Figure 204: Selection conditions for the view "Frances' old stuff".  The only 
condition is that an article field called ArticleAuthor must contain the name 
Frances. 

3. If you want to add a new condition, click on <Add Condition…>. 

L see section 5.6i: Conditions for information on adding conditions. 

4. If you want to edit a condition: 

a. Click on the condition to be edited. 

b. Click on <Edit Condition…>. Make the required changes 

c. Click <Add>. Your changes are saved. 

If you do some non-technical administration as well as create articles… 

and you want your view to only list articles where you are an author, not everything 
that you have created then make sure that your selection condition has the 
following: 

Condition: By field 
Field: ArticleAuthor  contains 
Value: (your name, as it is entered in edDesk) 

View properties 
View properties control the appearance of the entire view.  This includes colours 
used, text fonts and the view name. 

The View properties dialogue box must be displayed before you can change view 
properties. 
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Figure 205: View properties dialogue box 

If the View properties dialogue box is not displayed click on the Database 
.properties icon 

Renaming a view 

1.	 Click on the View info tab (the left tab in the View properties dialogue 
box). 

2.	 Name: enter the new name for the view. 

 Style attributes 

Style can make your view easier to use. Style lets you change the layout of the 
view. Some of the style options can also be changed in the Customize View 
dialogue box. Changes you make in this tab are shown straight away in the top of 
the Design View pane. 

Note 

Not every option is discussed here.  You can experiment with the style options and 
see the results immediately and without affecting which articles are listed. 

1. Click on the Style tab (second from the right in the View properties 
dialogue box). The Style tab opens. 
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Figure 206: Styles tab 

2.	 Body: used to select colours for the view. 

•	 Row: select a colour for the background of the view 

•	 Alternate rows: select a different colour for alternate rows to have 
a different background colour. This makes your view easier to 
read. 

3.	 Grid: sets a style for gridlines in the view.  Grid displays according to the 
settings in the Header option. Be careful with the Grid option as it can 
make your view harder to read. 

•	 Style: select a style. The default is none. 

4.	 Header: Shows a bar at the top of the view, with column titles in different 
looks. Your settings here affect how the Grid displays. 

•	 Style: select a style. 

•	 Height: specifies how many lines the header will take up.  If you 
have long column titles you may want more than one line for the 
header. 
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5.	 Rows: specifies how many lines a column can contain and the spacing 
between each row.  Articles that use more than this will have information 
truncated. You can also make these settings in the Customize View 
dialogue box. 

6.	 Other: 

•	 Show selection margin – displays a margin to the left of articles in 
the view. Selected articles are indicated with a tick.  This makes it 
easy see when you are selecting multiple articles. 

Figure 207: Document selection margin with some selected articles 

•	 Hide selection margin border – if the selection margin is visible, 
this will remove the border between the margin and the article 
information. 

•	 Extend last column to window width - select this to make your 
view easier to read. 

7.	 Margin: Lets you select the amount of whitespace around the view 
contents. 

Column properties 
Columns contain information about each listed article.  Column properties let you 
rename the column, change the display of column headings and contents, and sorting 
of articles within the column. 

Display the Column properties dialogue box. If the Column properties dialogue 
box is not displayed click on the Database properties icon . If the View 
properties is displayed, click on the dropdown list in the top left of the dialogue box 
and select Column. 
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Figure 208: Changing the properties dialogue box from View 

Renaming a column 

1.	 Move your mouse to the View Preview pane. Click on the column header 
that you want to rename. 

Note 

If you click on the column contents the Column properties dialogue box 
changes to the View properties dialogue box.  Click on the column header 
to redisplay the Column properties. 

2.	 Title: enter the new name for the column. 

Changing the display of column headings 

1.	 Click on the Title tab 

2.	 Select your title attributes. 

3.	 If you want to have the same title styles for each column click on 
<Apply to All>. 

Changing the display of column contents 

1.	 Click on the Font tab 

2.	 Select the font attributes. 

3.	 If you want to have the same style for each column click on <Apply to All>. 

Sorting column contents 

Sorting columns lets you organise the view display so that it is easier read.  For 
example, if you have created a view that lists all of your articles by date, you might 
want to sort the dates so that the oldest article is at the top or bottom of the view. 

1.	 Click on the Sort tab . The Column Sort dialogue box displays. 

. 

. 
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Figure 209: Column Sort dialogue box 

2. Change your sort options as required. 

• Sort: 

o	 Ascending - sorts in increasing order. That is numerical 
starting at the lowest number, then alphabetical, earlier dates 
before later dates. 

o	 Descending – sorts in decreasing order.  That is, largest number 
down to smallest number, reverse alphabetical (Z-A), later 
dates before earlier dates. 

• Type: 

o	 Standard – Repetitive information in a column is listed 
separately for each instance of that information.  For example, if 
you are sorting the author column and there are several 
articles by the same author, the author name is repeated for 
each of their listed articles. 

o	 Categorized - groups same information in a column together.  
This is useful to get a list of articles by particular authors so 
that the author name is not repeated next to each listed article.  
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Figure 210: Author column is sorted with Type: Standard.  Red colour just means 
that the article has not been read by the view creator. 

Figure 211: Author column is sorted with Type: Categorized.  Red colour just 
means that the article has not been read by the view creator. 

•	 Case sensitive sorting – sorts lowercase before uppercase. 

•	 Accent sensitive sorting – sorts accented characters after non-
accented characters. 

•	 Categorized is flat version 5 or greater – don’t worry about this! 

•	 Click on column header to sort – Tick this option so that when you 
are using the view if you click on the column header you will 
change the sort order. This is useful! 

•	 Secondary sort column – Lets you have multiple levels of sorting.  
For example, if your first column sorts by author, you might like a 
second column sorting by date, so that all the author’s articles are 
listed in date order. 
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Saving a view after you have designed it 
There are a few ways of saving your view from the Design pane.  Do one of the 
following: 

1.	 Press <Ctrl> + s; OR 

2.	 Select the File menu then select Save; OR 

3.	 Click on the close icon (the cross at the top right of the View tab name).  
You are prompted “Do you want to save your changes?” 
Click on <Yes>. 

RENAMING A VIEW 

Make sure your view names indicate the type of information displayed by that view.  
If you have modified your view since creating it, you may need to change its name. 

1.	 Go to the view to be renamed. 

L see Going to your view for instructions. 

2.	 Select the Actions menu. 

3.	 Select View Options. 

4.	 Select Rename… 

5.	 The Rename dialogue box displays. 

Figure 212: Rename dialogue box with old name highlighted 

6.	 Type the new name for your view. 

7.	 Click <OK>. Your view is renamed. 

DELETING A VIEW 

1.	 Go to the view to be deleted. 

L see Going to your view for instructions. 

2.	 Select the Actions menu. 

3.	 Select View Options. 

4.	 Select Remove View. 

5.	 You are prompted This action may not be undone. Are 
you sure you want to delete the view (your view
name) from this database? 

6.	 If you really want to delete the view click <OK>. 
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